
 
 

 

GUIDE RAPIDE: COMMENT CRÉER DES FICHIERS MEDIA POUR L’ ESPRECIOUS 
 

 
Ce guide rapide vous explique, en quelques étapes, comment créer des fichiers média pour l’Esprecious. 
L’Appendice 1 explique comment importer les fichiers média dans l’Esprecious. Note ! Une carte SD est nécessaire 
pour l’importation de fichiers média. 
 
Vous pouvez changer et importer différentes sortes de fichiers média : 
1. Image d’écran Boissons 

L’Esprecious affiche à l’écran jusqu’à huit images de boissons. Vous pouvez modifier vous-même ces images 
de tasse/mug affichées en standard par Bravilor Bonamat. Vous pouvez obtenir sur demande, un dossier 
compressé ‘Fichiers PNG de boissons’ comportant toutes les images standard tasse/mug au format PNG. 

2. Image d’écran de veille 
Vous pouvez modifier l’image de l’écran de veille qui s’affiche après env. 3 minutes de non utilisation de la 
machine, si le mode veille est activé. 

3. Image d’écran de fond 
L’image d’écran de fond est celle qui figure derrière les tasses/mug dans le menu principal. Vous pouvez aussi 
modifier cette image. 

4. Écran de veille avec vidéo (et son) 
Vous pouvez convertir une vidéo en votre possession dans un format plus petit pour que l’Esprecious puisse 
l’afficher et la jouer comme écran de veille. L’écran de veille vidéo s’affiche au bout d’env. 3 minutes de non 
utilisation de la machine, si le mode veille est activé. 

 
Note ! Vous devez avoir une carte SD pour importer des fichiers média dans l’Esprecious. 
 
 

1. ÉCRAN BOISSONS 
 
Les caractéristiques de l’image pour chaque boisson sont impérativement les suivantes : 

- Fichier au format PNG avec un arrière-plan transparent. 
- Largeur 295 x Hauteur 210 pixels. 

 
Pour commencer 

- Bravilor Bonamat peut vous adresser un dossier compressé ‘Fichiers PNG de boissons’. Ce dossier 
compressé comporte toutes les images boissons (tasse/mug) au format PNG utilisé par la machine de 
façon standard. Ces images ont déjà toutes les caractéristiques requises (nombre de pixels et arrière-plan 
transparent). Nous vous conseillons d’utiliser ces fichiers PNG pour commencer. 

 
- Ensuite, vous pouvez ajouter le logo de votre entreprise ou votre marque de café sur ces fichiers PNG de 

tasses/mug. S’assurer simplement que l’arrière-plan demeure transparent au moment de l’enregistrement 
du fichier. C’est pourquoi nous vous conseillons d’utiliser le logiciel Adobe Photoshop ou un autre logiciel 
similaire de création de photo. S’assurer également d’enregistrer les fichiers image au format PNG. 

 
- Si vous êtes déjà en possession de photo de tasses marquées à votre identité et de votre logo, vous pouvez 

les utiliser. Dans ce cas, il faut impérativement vérifier que leurs caractéristiques sont celles définies plus haut 
et qu’elles possèdent bien un arrière-plan transparent. Le cas échéant, vous devrez peut-être les modifier pour 
leur attribuer ces caractéristiques, sous Adobe Photoshop ou un autre logiciel similaire. 
 
- Lorsque vous enregistrez vos fichiers PNG, assurez-vous de leur donner un nom simple, comme café, 

cappuccino, espresso, etc. Enregistrez ces fichiers sur votre carte SD. 
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2. ÉCRAN DE VEILLE : IMAGE 

 
Les caractéristiques de l’image de l’écran de veille sont impérativement les suivantes : 

- Fichier JPG ou PNG. L’arrière-plan transparent n’est pas nécessaire. 
- Largeur 600 x Hauteur 950 pixels. 
 

Pour commencer 
- Créez une image. Pour l’écran de veille, un logiciel simple de photo, comme Paint par exemple, suffit.  

Si vous souhaitez utiliser Paint, respectez les étapes suivantes : 
 
- Ouvrir Paint (click sur le bouton Windows en bas à gauche de votre écran PC, choisir : All Programs, 

Accessories puis Paint) 
o Click sur Resize 
o Sélectionner Pixels et Décocher la case « Maintain aspect ratio » si elle existe 
o Renseigner : Horizontal = 600 (s’assurer que Pixels est bien coché et non pas Percentage !) 
o Renseigner : Vertical = 950 
o Click sur OK 
o Vous avez ainsi créé une image blanche d’Écran de veille avec les bonnes caractéristiques. 
o Vous pouvez à présent y coller votre image choisie ou logo. 
o Choisir Save as et JPEG picture (utilisez un nom court, comme « Écran veille ».). Enregistrez ce 

fichier JPG sur votre carte SD. 
 
 

3. ECRAN DE FOND 
 
Les caractéristiques de l’image d’écran de fond sont impérativement les suivantes : 

- Fichier PNG avec arrière-plan transparent ou fichier JPG avec arrière-plan de couleur très sombre. 
- Largeur 600 x Hauteur 1024 pixels. 
- Nous vous conseillons fortement de ne pas utiliser une couleur claire ou le blanc : Le nom des boissons 

serait alors difficilement visible, de même que les tasses/mug blancs. 
 

Pour commencer 
- Créez une image. Pour créer une image vectorisée avec arrière-plan transparent, vous pouvez utiliser 

Adobe Photoshop. Si vous souhaitez créer une image avec arrière-plan de couleur (foncée) vous pouvez 
le faire avec Paint. Dans ce cas voir le paragraphe 2 ci-dessus. 
Surtout ne pas créer d’image avec un fond blanc ou clair ! 

 
- Si vous utilisez Adobe Photoshop, respectez les étapes suivantes : 
- Ouvrir Adobe Photoshop. 

o Click sur Fichier 
o Click sur Nouveau 

§ Nom : Écran de fond  
§ Largeur : 600 pixels 
§ Hauteur : 1024 pixels 
§ Résolution : 72 pixels/pouce 
§ Mode : Couleurs RGB 8 bits 
§ Contenu de l’arrière-plan : Transparent 

o Click sur OK 
o Vous avez ainsi créé un fichier d’Écran de fond de base avec les bonnes caractéristiques. 
o À présent, vous pouvez copier et coller l’image de votre choix ou votre logo sur ce fichier de base. 
o Une fois cela réalisé, click sur Fichier. 
o Choisir Enregistrer sous (nom de fichier = Écran de fond). 
o Choisir le format « PNG (*PNG, *PNS) » et click sur Save. Enregistrer cette image d’écran de 

fond sur votre carte SD. 
 
 
Voir l’Appendice 1 pour importer ces images d’écran boissons, d’écran de veille et d’écran de fond sur 
l’Esprecious >>.  
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4. ÉCRAN DE VEILLE AVEC VIDÉO (ET AUDIO / SON) 

 
Les caractéristiques exactes d’un écran de veille vidéo dépendent de plusieurs paramètres et réglages, comme le 
son (ou muet), la rapidité d’animation des images, le format de la vidéo elle-même... 
 
Les caractéristiques ci-dessous nous servent de principe général de base. Toutefois cela peut varier d’une vidéo à 
l’autre. Selon la vidéo, la fréquence de trame et le débit binaire doivent être augmentés ou diminués. C’est une 
question d’apprentissage. Vous pouvez affiner ces caractéristiques jusqu’à ce que vous soyez satisfait du résultat. 
 

 Taille (pixels) Fréquence de 
trame (f/s) 

Débit Binaire Vidéo 
(kb/s) 

Débit Binaire 
Audio (kb/s) 

Format 
de fichier 

Vidéo 600 x env. 340 (LxH) 15-24 < 400 - MPEG-4 
Vidéo avec audio/son 600 x env. 340 (LxH) 15 < 350 64 MPEG-4 
Diaporama (plein écran) 600 x 1024 (LxH) < 1 400 16 MPEG-4 
 
NOTE ! Si vous ne souhaitez pas avoir d’écran de veille animé, mais juste du son, il faudra tout de même créer 
une vidéo en vous servant simplement de votre image d’écran de veille pour le visuel et ajouter votre son. Il suffira 
d’indiquer que la durée du visuel est égal à celle de la bande sonore. 
 
Les étapes ci-dessous sont basées sur le logiciel Adobe Premiere. Bravilor Bonamat collabore avec une agence 
pour les vidéos de son Esprecious. Si nécessaire, nous pouvons demander à cette agence d’adapter votre vidéo 
existante à ces caractéristiques. 
 
Il vous est également possible de télécharger une version d’essai gratuite valable 30 jours du logiciel Adobe 
Premiere, voir https://creative.adobe.com/fr/products/download/premiere  

 
Pour commencer 

- Ouvrir Adobe Premiere. 
- Créer un nouveau projet. 
- Changer le nom du fichier et son emplacement. Note ! Ne pas utiliser un nom comportant des espaces ! 
- Menu : → Fenêtre → assurez-vous que les fenêtres ci-après sont activées : 

o Effect Controls 
o Program Monitor 
o Project 
o Timeline 

Vous avez besoin de ces fenêtres pour suivre les étapes suivantes. 
 

- Menu : → Fichier → Import... et sélectionner votre vidéo dans le navigateur. 
 

- Glisser la vidéo importée de la fenêtre Project vers la fenêtre Timeline. 
La vidéo est maintenant prête à être éditée. 
Pour information : dans la fenêtre Program vous pouvez appuyer sur play et jouer la vidéo. 
À présent le format de la vidéo doit être changé. 
 

Pivoter la vidéo et modifier les dimensions 
- Menu : → Sequence → Sequence settings 

Modifier la taille à Frame Size : 338 horizontal, 600 vertical 
 
Note : la vidéo dans l’Esprecious sera pivotée automatiquement. C’est pourquoi les valeurs doivent être 
renseignées vice versa : la largeur maximale de l’affichage est de 600 pixels (donc la valeur 600 doit être 
renseignée à « vertical ») et la hauteur de la vidéo (écran 16:9) sera d’environ 338 pixels (donc la valeur 
338 doit être renseignée à « horizontal »). 
 

- Double click dans la fenêtre Program sur la vidéo (ça peut être un écran noir)). 
La vidéo s’activera dans la fenêtre Effect Controls. 

 
- Sélectionnez la fenêtre Effect Controls. Click dans la fenêtre sur l’onglet de la vidéo. Modifiez les valeurs 

comme suit :  
o Video Effects → Motion → Rotation : 270° 
o Video Effects → Motion → Position : 169 et 300 (= Centre du ‘test’ vidéo) 
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o Video Effects → Motion → Scale : assurez-vous que l’écran noir est totalement rempli (dans ce 

cas case 94) 
 
Dans la fenêtre Program vous pouvez appuyer sur Play et jouer la vidéo. 
La vidéo nécessite d’être tournée à 90° dans le sens inverse des aiguilles d’une montre et remplir 
pleinement l’écran. Si des bordures noires persistent autour de la vidéo, c’est que le processus 
d’échantillonnage ne s’est pas fait correctement et de nouveaux réglages doivent être effectués. 
 

Enregistrement : comment exporter la vidéo au format MPEG-4 ? 
- Sélectionnez la fenêtre Program ou Timeline 
- Menu : → File → Export → Media 

Pour information : le menu d’exportation s’ouvre. Modifiez les réglages ci-dessous. 
Les valeurs du débit binaire peuvent servir de guide. Les nombres seront modifiés vidéo par vidéo pour 
obtenir le meilleur résultat. Pour une vidéo « test » les bons réglages sont les suivants : 
 

o Export Settings – Format : H.264 
o Export Settings – Preset : Custom 
o Export Settings – Output Name : nomsociété-vidéo (notez que le nom du fichier ne doit comporter 

aucun espace !) 
o Export Settings : cochez la case vidéo (et Audio si disponible) 

 
- Sous Export Settings, sélectionnez l’onglet vidéo et modifiez les valeurs de réglage comme suit : 

o Basic Video Settings – Frame-rate : 15 
o Bit rate Settings – Bit rate Encoding : CBR 
o Bit rate Settings – Target Bit rate [Mbps] : 0,35 

 
- Sélectionnez l’onglet audio (seulement disponible si la case Audio a été cochée précédemment dans 

Export Settings). Modifiez les valeurs de réglage comme suit : 
o Audio Format Settings – Audio format : AAC 
o Basic Audio Settings – Audio Codec : AAC 
o Basic Audio Settings – Channels : mono 
o Bit rate Settings [kbps] : 64 

 
Pour information: la valeur de référence du débit binaire total (vidéo et audio ensemble) doit être inférieure à 
0,4 Mbps (comme c’est le cas dans la vidéo « Test »). Si la vitesse de la vidéo est toujours trop faible ou si la 
vidéo et l’Audio ne s’accordent pas, le débit binaire total doit être réduit. Plus la vidéo est compliquée, plus le 
débit binaire doit être bas pour obtenir une vidéo adéquate. Si le débit binaire est trop bas au point d’entrainer 
une mauvaise qualité de la vidéo, il faudra envisager une vidéo sans audio. 

 
Comment enregistrer la vidéo sur une carte SD en étant sûr qu’elle soit reconnue automatiquement par 
l’Esprecious 

- La vidéo ou diaporama doit être au format MPEG-4. 
- Le nom du fichier ne doit comporter aucun espace. 
- La vidéo doit être enregistrée dans un dossier à créer sur la carte SD et à nommer screensavervideos. 
- La carte SD doit demeurer dans l’Esprecious, celle-ci lisant la vidéo directement depuis la carte SD. 
- La fonction “écran de veille” doit être activée dans le programme (cf. appendice 2). 

 
Si vous utilisez un écran de veille avec vidéo, nous vous conseillons de créer également une image d’écran de 
veille (cf. point 2) et d’importer ce fichier média dans l’Esprecious. La vidéo et l’image d’écran de veille apparaîtront 
simultanément au bout d’environ 3 minutes de non-utilisation de la machine. 
 
Pour davantage d’informations, merci de contacter Bravilor France au +33 (0)1 34 34.47.74 ou d’adresser un e-
mail à info.fr@bravilor.com. 
 
Bravilor Bonamat BV 
 
Pour recevoir quelques exemples de fichiers média, demandez à votre contact Bravilor de vous adresser le dossier : 
‘Fichiers d’écran de veille, fond et d’écran et vidéo’. 
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Étape 1

Étape 7

•	Ouvrir la porte avant avec 
la clef.

•	Insérer la carte SD card 
comportant vos fichiers 
média.

•	Appuyer sur le bouton noir P 
situé sur l’intérieur de la porte.

Une fois les images changées, 
vous voyez que les icônes 
sont modifiées et représentent 
les images que vous venez 
d’importer. Ces images seront 
celles affichées sur l’écran 
principal.

•	Appuyez sur le symbole <.

•	Appuyer sur Entretien.

•	Appuyez sur le symbole de la 
Maison.

•	Appuyer sur Carte SD.

•	Appuyez sur le symbole 
de la Flèche rouge.

Vous voyez à présent les 
icônes des fichiers média 
actuellement actifs.

•	Appuyez sur le bouton (nom 
de la boisson) de l’icône que 
vous souhaitez modifier.

Les fichiers présents sur votre 
carte SD apparaissent alors à 
l’écran.

•	Sélectionnez le fichier 
média que vous souhaitez 
importer. Au bout de quelques 
secondes, l’écran précédent 
réapparaît.

Note : la sélection multiple 
de fichiers n’est pas possible. 
Si vous souhaitez importer 
plusieurs fichiers, faire cette 
opération (étape 5) fichier par 
fichier.

Pour revenir aux fichiers 
média d’origine, suivre 
les étapes 1 à 4. Puis :

•	Appuyer sur le bouton 
Retour aux fichiers 
médias d’origine.

Et suivre ensuite les 
étapes 7-9.

•	Appuyer sur Importez des 
fichiers média.

Notez que si vous n’avez 
pas inséré de carte SD 
(ou convenablement), 
ce bouton n’est pas actif.

L’écran boisson apparaît à nouveau et vous 
pouvez donc voir la nouvelle interface que 
vous venez de créer :
•	Nouveau fond d’écran et 
•	Nouvelles images boissons
À cette étape, l’Esprecious est à nouveau prête 
à fonctionner.

La carte SD peut être retirée, car vos fichiers 
média sont chargés dans la machine,  
à l’exception des vidéos pour lesquelles la 
carte SD doit demeurer dans la machine.

Étape 2

Étape 8

Étape 3

Étape 9

Étape 4

Étape 10

Étape 5

Étape 11

Étape 6
A
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Étape 1

Activation de l’écran de veille.

•	Ouvrir la porte avant avec la 
clef. 

•	Appuyer sur le bouton noir P 
situé sur l’intérieur de la porte.

•	Sélectionner Réglages de 
la machine.

•	Sélectionner Réglages 
généraux.

•	Vérifier que Écran de veille 
est bien en MARCHE 
(encadré gras). Sinon 
sélectionner MARCHE.

•	Sélectionner Mettez en 
marche/Arrêtez des fonctions.

Étape 2 Étape 3 Étape 4 Étape 5

A
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